
D I G I TA L  N E G AT I V E S  W I T H  Q U A D TO N E  R I P

step-by-step

Creating a Quadtone RIP (QTR) digital negative profile from scratch seems to have gained a 
reputation for being a painful and fussy process. This perception may have something to do with 
the fact that the first time one goes through the process from start to finish, it is both painful and 
fussy, not to mention daunting. But keep in mind that the basic steps common to all of the existing 
methods for digital negative creation can be used for the QTR method as well. Every method has 
its pros and cons, but I am convinced that the serious worker using  the Epson printers necessary 
for QTR will gain a degree of control over the process that is unavailable in any other approach.

 A list of the materials

First, lets cover the materials you will need to gather together to complete this project:

1. Pictorico OHP or another clear film capable of holding onto the pigments or dyes used in 
your printer.

2. A  narrow 21 step or 31 step graduated test wedge from Stouffers, ( http://
www.stouffer.net/TransPage.htm )  or a comparable transmission step wedge. I recommend 
either the  T2115 (21 step with 1/2 stop increments) or the T3110 (31 step with 1/3 stop 
increments). Don’t bother paying the extra money to get a calibrated step wedge. 

3. All of the material necessary to produce a positive print from your negatives.  In short, a 
palladium printing kit, a cyanotype kit, albumen print materials, silver gelatin paper and the 
necessary chemicals, etc... in short,  whatever you need to make a print from a negative.

4. A method of accurately measuring the exposure time of your prints. Be aware that many 
fluorescent UV boxes require a warm-up time to achieve a stable light output. Don’t assume 
that you can just flip the light on and get a consistent result.  When using UV boxes, I prefer to 
leave them on during my entire printing session to maintain the stability of the light output and 
using any number of methods to keep stray UV light from the box out of the coating and 
drying area.

5. A copy of Ike’s script ( “Build QTR Curve.jsx” ) for calculating a photoshop correction 
curve. This script should be put in /Applications/Adobe Photoshop CS4/Presets/Scripts/ if you 
are using a Mac, and the comparable directory if you are using a Windows computer.

6. A copy of some of the standard QTR curve design files where you can easily access them. 
Specifically, you will need:

a. “21step.psd” - which is the basic step wedge on which we will run our initial curve 
correction routine



b. “inkseparationN.tif ”,  The value for N will depend on which printer you are using for 
your negative creation. For instance, on the 7800, which is an 8-ink printer, I use 
inkseparation8.tif. 

7. A copy of my torture test file for final tweaking. This file is named “B&W Test.tif ”

8. A working knowledge of the basics of getting QTR running on your system. Ron Reeder’s 
excellent write-up can walk you through the basics for setting up a Mac system.

9. Access to a flatbed scanner capable of scanning your test prints and creating a tiff image 
file.

10. Finally, while this is optional, it will make your life infinitely easier if you are using a Mac. Get 
a copy of either VMware Fusion or Parallels for your intel-based Mac and install it along with a 
working copy of some flavor of Windows.  As much as it pains me to say this, the QTRgui that 
is used for the Windows version of QTR makes curve design SO much easier than the rather 
primitive scripting approach needed on the Mac version. The basic approach I will outline will 
work for either system, but since I primarily use a Mac, I find it much easier to envision what is 
going on with the Windows version, so I typically have both a Windows session running in a 
window on my Mac desktop. Fortunately, the profiles created for either system are completely 
interchangeable.

An overview of the steps

1. Establish a base printing time for the print process using your negative substrate (Pictorico, 
or whatever you are using). We will also be able to determine the basic exposure scale of the 
print process with this step.

2. Print out the ink separation test on your transparency substrate using your printer, and then 
printing this output ‘negative’ using your targeted print process using the print time established 
in step 1.

3. Evaluate the print from step 3 and determine if your inks have sufficient density to block 
the UV light necessary for your process. If individual inks do not have sufficient density on their 
own, they can sometimes be combined to achieve the necessary UV blocking density.

4. Design your QTR ink profile (ideally using the QTRgui interface)

5. Print the 21 step tablet using your QTR ink profile.

6. Scan the 21 step tablet without any clipping and use Ike’s magic script to create a 
photoshop correction curve. Then you will reference this profile in your ink profile.

7. Reprint the 21 step tablet and evaluate your profile. At this point, you may also print the 51 
step “B&W Test.tif ” file for fine tuning your profile.



8. Make adjustments to the correction curve as need to create a smooth progression of tones 
for your printing process. Repeat step 7 if corrections are necessary. The amount of time you 
spend on iterating these last two steps depends on how fussy you want to be with your 
profile. I find that a handful (say 2-3) of iterations are all that are necessary. 

A detailed step-by-step description

Step 1 - Establish a base printing time

This is perhaps the most important step, because all subsequent steps depend on your ability 
to consistently repeat both the exposure and the processing steps necessary to produce a print in 
your chosen process. 

We are going to intentionally overexpose a print using the Stouffer’s step wedge to hold back 
some of the light. What this will allow you to do is to find out what is the minimum exposure time 
necessary to create a true, full black1 with your chosen printing process.  This step will also establish 
the exposure scale of your chosen print process.

First, either coat the paper you intend to expose, or prepare your paper if you are making a 
profile for silver gelatin printing.  There are some considerations you need to keep in mind at this 
point. 

First, if you intend to do any sort of contrast control in your coating chemistry, you need to 
decide right now what that will be. For instance, many workers like to add small amounts of the 
Na2 contrast control agent to their palladium prints. If you fall into this category, it is essential that 
you write this information down, and maintain the same ratio of ferric oxalate, palladium metal salt 
and Na2 platinum salt in this calibration step and through all your future printing with digital 
negatives. If you change your chemistry, you will need to re-evaluate your profile and most likely 
make adjustments to it. 

Next, if you are doing one of the coat-it-yourself alternative processes like palladium, cyanotype 
or albumen, make sure you do your calibration with freshly mixed chemistry. For instance, in 
palladium printing, two or three-month-old ferric oxalate will lose some speed and gain in contrast, 
whereas freshly mixed ferric oxalate will have longest exposure scale and shortest print time.  
Calibrating your process with old chemistry and then printing with fresh chemistry in the future is a 
sure way to confuse yourself.

Similarly, if you are doing a silver gelatin profile, you need to decide up-front what your 
preferred contrast filter will be if you are using multi-contrast paper. I would recommend using 
something around grade 3, since most papers have reasonably linear results as long as you stay 
away from the extreme grades of 00, 0 and V and VI.

1 More precisely, what we are doing is establishing the minimum exposure time for maximum print density. In the case 
of cyanotype, for instance, the ‘black’ is actually a very, very deep blue. Specifically in regard to cyanotype, realize that 
the maximum print density will not appear for a few days unless we hurry along the oxidation process. So if you are 
creating a profile for cyanotype, there is a great time saving trick to making this happen. After washing the unexposed 
sensitizer from the paper (the yellow stuff), drop the print in a tray of water in which a capful of hydrogen peroxide has 
been poured. It will intensify immediately. Rinse and dry the print after this for your evaluation.



So once you have picked your printing method and contrast control (if any), and coated your 
paper (if necessary) you will then use either the Stouffer 21 step wedge or the 31 step wedge and 
a piece of your negative substrate along with a piece of rubylith to determine your base printing 
time ( I would like to call this the Base Underlying Level of Light Sensitivity with a Halftone Interval 
Timing methodology, or BULLSHIT™ 2, but I can’t do it with straight face). 

Here is how you need to arrange these items on your paper: Put down the printing paper,  and 
lay down the step wedge on top of it.  Then overlap half of the step wedge with your negative 
printing transparency material.  Now take a piece of rubylith and run it from a coated area to an 
uncoated area of your paper. Here is a picture of what it will look like:

Expose the print for roughly twice the time you expect you will need. The reason for this 
overexposure is to make sure that you get the maximum print density your process is capable of 
rendering, and this overexposure will also tell you what happens when you do overexpose. 
Palladium, for instance, quite easily solarizes and prints with less density if too much exposure is 
used. This method will smoke out what happens. The reason for using the rubylith is to determine if 
there is any fogging of your chemistry, and also if you have any clearing problems in the case of 
palladium or platinum printing.

2 Yes, I am making fun of PDN here. It is acronym heaven over there in the PDN world. And every goddamn one of 
them has a trademark stamp on it. Sheesh.



Process and dry your print. Once it is dry, find the lighter areas that were exposed beneath the 
transparency film, and trace down until you reach the first solid black area that has the same visual 
density as the one just below it, like so:

A few other things can be learned from this test. If you look closely, the last light step exposed 
under the transparency material that still shows tone (allowing for the imperfect scan) is step 27. 
So with black being at step 3 and white at step 27, the difference is (27-3) or 24 steps. Each step is 
0.1 density change, so this means that the exposure scale necessary to print from pure black to 
pure white with this palladium printing process is 2.4 logD.  As a rule of thumb, each 0.3 of logD is 
one stop, a doubling (or halving, if you move the other direction) of light intensity. So this means 
that the negative needed to print a full scale print in palladium needs an 8 stop difference in its 
densities from dark to light.

Also note that the top half of the strip has a black tone ever-so-slightly less dark than what is 
seen under the pictorico. This is because it was exposed to the full intensity of the UV light, and 
that area has begun to solarize (get less print density with increased exposure). The white strip 
where the rubylith was placed shows some slight fogging. In this case, it is because I was using two 
month old ferric oxalate. If I were doing this for my own work instead of as a teaching tool, I would 
stop right here and mix up fresh chemistry. There is no point in calibrating your process to funky 
chemistry. In this case, the fogging is imperceptible except to dedicated print sniffers like myself, so I 
will continue using this ferric for the purposes of illustrating the process. Just don’t tell anyone what 
I did. 

So now we can calculate our basic exposure time. In my example, I had exposed the original 
for 500 units on my Amergraph exposure unit. I need one stop less exposure for my printing time, 
since it took 0.3 density of light blocking by the exposure strip to still yield a solid black. Any more 
light blocking, and we are into the gray areas of the test strip. In my case, I decided to use a 275 
unit exposure as my base exposure, because I was wavering back and forth whether it was just 
slightly more black at step 2. So I gave it a nudge. Which should indicate that while the exposure is 



important, it is really more important that it be consistent for the rest of the steps we will be 
covering.

Step 2 - Print out the ink separation test in Quadtone RIP calibration mode and make a print

This step is pretty easy. Find out how many inks your Epson printer uses. Find the location of 
the ink separation tests that came with Quadtone RIP3. Now open the file in Photoshop if you are 
using a Mac, or go to Tools->Options->Calibration Mode in the QTRgui application if you are using 
Windows. Print the test on your chosen. If you are using Windows, just press print after insuring 
that the proper printer has been selected. On a Mac, make sure that you see a file that looks 
similar to this in Photoshop:

And then choose the QTR printer in your print setup. When you press Print..., you should 
choose No Color Management, and select the QuadTone RIP options menu (The selection box 

3 On a Windows computer, it should be c:\Program Files\QuadToneRIP\bin\inkseparationX.tif, where X indicates the 
number of inks your printer uses. On a Mac, it is located at Macintosh HD:/Applications/QuadToneRIP/CurveDesign/
Images/inkseparationX.psd



right below Presets: ) on the final print dialog. Make sure you choose the Mode to be Quadtone 
RIP Calibration. Pick your desired resolution (probably the 2880) and print speed.  A full letter-size 
sheet of your transparency material will probably be required to fully print this test.

Now allow the ‘negative’ to dry thoroughly4.  If there are any ink smears because the 
transparency material cannot absorb it quickly enough, make a note of the color and ink 
percentage where this occurs.  The ink percentages where smearing occurs will be useful later on 
during the curve design phase. Coat a whole sheet of paper and print the ink separation test using 
your newly calculated base printing time. 

4 As a parenthetical aside, it is vitally important that the negatives being printed are dried very thoroughly during the 
calibration phase and all subsequent printing with the profile. The UV absorption properties of the transparency film 
and ink will change as the ink dries. You can hurry the process with a hair dryer or a negative drying cabinet. It is 
probably best to wait a few hours. But life is short. Use a hair dryer and make sure you don’t see any milky looking 
areas when looking at the negative from the back.



Step 3 - Evaluate the Ink Separation Test

Use your normal processing sequence to completely process, wash and dry this test print.  
Ideally at this point, you should have a nice print that looks like this:

This test will allow some useful observations. First, it is quite obvious which inks are effective in 
blocking UV light and which are not. In this test from my 7800 printer, it is apparent that the Black 
(K) ink and the Yellow (Y) are the best blockers of UV light for the palladium process. Coming in 
third is the Light Black (LK) ink.  The worst is Light Magenta (LM). So it looks like we should design 
a profile using Black and perhaps a touch of Yellow for the highlight areas, and use the LK and LLK 
to provide ink density in the shadow areas. 

You may well ask why we bother with the LK and LLK inks at all.  The reason is that they 
perform the same function in the shadow areas of your negative as they do in the highlight 
portions of a print using this same printer : they make the photo smoother. Using QTR, we will 
design a profile that gradually changes from LLK to LK to K inks as the steps move from shadows 
to highlights. Because we have complete control over the location of these transitions, and 
extremely smooth profile can be designed with no abrupt transitions anywhere in the tonal range 
from deepest shadows to lightest highlights.



The next step will be the preliminary curve design.  As mentioned above, it is better to start 
out with a simple selection of gray inks, and only add color if needed. One of the primary benefits 
to the QTR approach is that we can avoid putting dots of widely different UV absorption 
characteristics next to one another. 

Step 4 - Design the Curve using QTRgui

The procedure will look something like this: First find the ink percentage of the K ink where 
you get a pure white.  On my test, this looks like somewhere around 75-80% on the K ink and 
about the same on the yellow. Now we need to decide the maximum percentage LK ink we want 
to lay down on the negative. For no real good reason, I will pick 85% LK for this value. If your ink 
separation test negative had some ink smearing at some point for this ink, you would not want to 
go any higher than that value. For instance, if I noticed ink smearing at 65% LK, I would not want my 
LK to go any higher than that percentage.

Now it is some back to Kindergarten fun. Get a pair of scissors, and remove the printed strips 
from your palladium print for the LK and the LLK inks, cutting along the border between the steps 
and the background. Slide the LK strip next to the K strip and find where the grays match for our 
chosen 85% max value for LK ink, like so:

Don’t let your eye fool you by looking too far either direction on the steps. The rate of change 
between steps will be different for different inks. Concentrate just on the  gray value at the 85% 
LLK step. On my test, that comparable gray is at the 50% on the K strip. Write this number down. 



Now we are going to go through a similar exercise for the LLK ink. In the case of LLK, I decided 
that 100% ink will be okay to use. So do a similar thing with the LLK strip and find the comparable 
gray value between 100% LLK and the corresponding gray value on the K strip, like so:

On my test, the 100% LLK print value was the same as the 20% value on the K curve. Again, 
write this value down.

Now we will jump into the Windows based QTRgui to design the profile using this 
information. Start the QTRgui application and select from the menu Tools->Curve Creation. 
Another window will open up, perhaps with an error message. Just ignore it. Select your printer in 
the Printing Model selection box.  Next we are going to tell the driver how to lay down the ink on 
the transparency material using this graphical interface and the information from the ink separation 
printing test. 



As you can see, I have selected the correct printer for my profile creation. As a starting point, 
we will set the default ink limit to 100. This means that there is not global limit on ink percentage 
that would override any specific ink percentage request we design into the ink profile. We will also 
set black boost to 0. In general, if your ink separation print test yields a white area at ink 
percentages less than 100%, this can be left at 0 for now.

First, we will set the maximum black ink. This will be the whitest of whites in your print.  As 
noted above,  I was able to achieve a total white at somewhere between 75% and 80% K black 
ink. In QTR-speak, this is a Gray Ink. So I make sure I select K as a Gray Ink. 

For no real good reason other than habit, I will set the K black ink Limit to 70, and Density to 
100. What this means is that at 100% input density from my file, the printer will lay down 70% 
black ink. Not enough ink for a pure white, you say? 

Well, I am going to give it a boost by using a shot of Yellow ink alongside the Black. This is done 
by setting the selection box on the left side of the Yellow area to “Copy curve from” instead of 
“Gray Ink”. I then tell it to copy the K curve in the next box, and finally set the maximum yellow ink 
percentage to 10%. This tells the driver to proportionally lay down a fraction of Yellow ink 
wherever there is Black. In this example, at the 100% input density, the driver would lay down 70% 
Black and 10% Yellow. And wherever the Black (K) ink  is used, it will lay down 1/7 the amount of 



yellow ink at the same input density.  To make up an example, if the driver needed 50% black ink, 
then it would also lay down 35% x 1/7, or 5% Yellow ink at the same input density value.

Now I need to tell the driver how to add in the other gray inks - the LK and the LLK inks. This 
is accomplished by setting the leftmost selection box for both LK and LLK inks to ‘Gray Ink’. This 
means that the driver will smoothly transition between the three black inks based on the 
information we will supply in the next step. 

Remember we said that 85% LK ink gave the same print density as 50% K ink? So we will set 
the Density value in the LK ink area to 50% and the Limit at 85% because we arbitrarily decided 
that 85% LK ink was as much as we wanted to lay down. 

Similarly, we will set the density value in the LLK ink area to 20% and the Limit at 100%. This 
tells the driver that 100% of the LLK ink yields the same print value as 20% of the K ink. Now that 
the Ink Setup tab is complete, we will move to the next tab, which is the Gray Curve tab:

The Highlight and Shadow values both default to a value of 10. I leave them alone.  The things I 
do change are the Gamma, which is set to a default of 1.0.  Because almost every profile I have 
ever seen needs more density in the shadow areas of negative (lighter in the print) I have found 
that by dropping Gamma to anywhere between 0.3 and 0.7 will minimize the amount of work we 
will do in making a correction curve in the final step.  For my 7800, a gamma value of 0.7 seems to 
work fine. 0.6 would probably work too. The only gotcha to be aware of here is that 0.7 is not the 
same as .7 when the driver reads it. It needs to have that leading 0 in front of the decimal.



Finally, I put in a dummy curve in the curves box. The text string for a curve is enclosed in 
quotation marks, and the syntax is as follows:  value in; value out, with a space separating the curve 
pairs. I began using this placeholder curve in earlier versions of QTR which gave different results if a 
dummy (and theoretically meaningless) curve was put in the dialog box versus being left out. This 
oddity may be fixed now, but I figure it can’t hurt to leave it in. We will eventually be replacing this 
with a photoshop curve (a curve.acv file from photoshop) created by the script.

Finally, we need to save5 this profile as a new name. I chose 7800demo.qidf, which is QTR-
speak for a Quadtone RIP ink descriptor file. It is a simple text file and is completely 
interchangeable between the Windows world and the Mac world.  If you are using my hybrid Mac/
Windows technique, be sure and save the .qidf file to your desktop so you can easily drag it over 
to your Mac desktop for installation.6 ‘

To see what we have done, press the ‘Show Curve’ button and a graph will pop up showing 
how the inks will be distributed throughout the range of grays for an input grayscale print file:

5 The curve creation process on QTRgui has one peculiar thing: If you are modifying an existing profile, you must 
remember to save it under a new name before selecting ‘Show Curve’. If you don’t, wave bye-bye to the older version 
curve you needed to keep. Ouch.

6 I digress enough in this tutorial already, so I am adding a footnote about using the Windows-created profiles in the 
Mac-based QTR driver..  The easiest way is described by Ron Reeder in his excellent tutorial available on his website. 
The short version is this: find the folder in the /Applications/QuadtoneRIP/Profiles directory that contains your printer. 
For my system, this is the 4800-7800-9800-UC folder. Copy the appropriate InstallXXX.command file (where XXX is 
your particular printer model) to another folder on your desktop. You can then put your profiles and curves in that 
folder and double click the install command when you want to install a new profile. Be aware that you will have to exit 
and restart Photoshop for your computer to be aware that a new profile is available for printing using the 
QuadtoneRIP driver.



So we now have a preliminary profile. Make sure that the profile is installed in whatever system 
you are using, whether Mac or Windows based. 

Step 5 - Make a 21 step test wedge

The QTR systems include a 21 step tablet that we will use to make a preliminary test print 
using the profile we just made. Open this curve in Photoshop and invert it (Command-I) on the 
Mac or Image->Adjustments->Invert from the menu. Then select Image->Image Rotation->Flip 
Canvas Horizontal. Now the test strip is properly flipped and turned into a negative. If you are 
using a Windows system throughout, save the file as a .tiff and print it using the QTRgui 
application. If you are using a Mac, then use Print Setup to select QTR7800 or whatever Quadtone 
printer you are using in your process. Then select Print.. and make sure that Photoshop manages 
colors is turned off in the initial dialog. Here is what the dialog looks like in Photoshop CS2, which I 
use on the old Mac I use for a print server :



After pressing the Print... button, the final printing dialog will appear:

Make sure that the Mode is selected for Quadtone RIP (not the Calibration Mode we used 
earlier!) and that Curve 1 selects the QTR profile you just selected. It is helpful here to set the 
paper feed, resolution and speed buttons to your liking, and then save all of these setting as a 
printing preset. This will ensure that your settings are consistent as you go through the calibration 
process.

Finally press the print button after loading your transparency media into your computer, 
checking, as always that the side of the material that accepts ink is properly oriented in the printer. 
When it is finished printing, make sure the negative is completely dry by either waiting an adequate 
amount of time or hurrying the process along by using a hair dryer. 

Coat another piece of paper and print this step wedge using your baseline printing time 
established earlier.  Develop and process this paper in the usual way and let it dry. 



Step 6 - Scan the 21 step tablet

Here is what my first printed test wedge(uncorrected) looks like:

A few things are immediately obvious. First, we nailed the 0% pure white. That is good. If it had 
been gray, we would need to back up a step and redo the profile to lay down more ink in the 
highlight areas of the print (dense areas of the negative). The gradation from 0% to about 20% 
looks pretty good. The shadow values are all too dark and the midtones change too abruptly either 
direction.  But this is not a bad start. We can correct all these problems by using Ike’s script to 
design a correction curve that will be embedded in the driver. 

After it dries, scan the test wedge on a flatbed scanner, ensuring that no clipping of the white or 
black areas of the file occurs.7 Save the file as a .tif, and open it in Photoshop. Crop the scan as 
needed and make sure it is right side up and reads correctly. 

The next step is to run the script to create a correction curve for your first test. 

Simply select File->Scripts->Build QTR Curve , and the script will use the 21 step tablet to 
quickly go through the process of finding the pure white and black endpoints of the tablet, and 
calculating a curve that linearizes the profile in between the two endpoints so that the palladium 
print will resemble what is seen on screen while editing an image file in Photoshop. The script will 
whir and spin, perhaps releasing a little carbon dioxide into the atmosphere as it does its job. And 
finally, up will pop a curves dialog box.

7 There are about eleventy hundred things that can screw up your results in scanning the print. Try to keep all settings 
on your scanner wide open and make a scan that looks sort of flat with no complete dark or light areas.  The script will 
adjust the scan to take this into account. The scan also needs to be in grayscale for the script to work properly.



This curves dialog box shows the correction curve that (in theory) will linearize your profile. Is 
it perfect? Probably not. Here is what it looked like when we scanned the 21 step wedge shown 
previously and then ran the script on it:

I know that we want the both the black end and the white end of the curve to be anchored to 
their respective corners, with smooth transitions between the values, so use the mouse to move 
around the points a little to achieve something like this:

Notice we have smoothed the curve while trying to maintain the position of the point where 
the curve crosses over the diagonal line on the graph. In general, you can see that the curve 
correction script is doing exactly what our eyes told us needed to be done. It is keeping the 



highlight gradation more or less linear (remember that this will the the black areas of the negative) 
and expanding and lightening the tones in the shadow areas and increasing the contrast ( steeper 
curve means more contrast) in the shadows.

Next we need to save this curve to the folder where our profiles are being kept. This is 
important. From now on, the profile (the .qidf file) and the curve (the .acv) file have to be kept in 
together. If you try to install the profile without the curve present, we will get an error message 
and it will not load the new profile. To save the curve, click the tiny arrow in the upper right hand 
corner of the curves palette:

Now that we have a curve for linearization, we will direct the profile to use it by reopening the 
QTRgui curve creation dialog in the Windows, uh.. window. After clicking the ‘Gray Curve’ tab, we 
must first delete, the curve pairs we entered previously. Now we can then click on the Browse 
button on the right side of the Curve entry area and navigate to the location of the curve we 
created. It will have a .acv filename extension. After finding where the curve was saved in amongst 
all the other disk effluvia, the ‘Gray Curve’ tab will look like this:



Save the profile, preferably with a creative new name like PdCrv1.qidf or something both 
descriptive and with some indication of where this profile will fit in with the series of profiles you 
are likely to make as you zero in on your final profile. Once it has been saved, click the Show 
Curve button again to see what the driver will do with all the inks:

Compare this to the uncurved original:

Notice how much more ink is being used in the shadow areas, and a little less ink in the higher 
midtones. This is exactly what you want. More ink density (on the negative, remember) will lighten 
the shadows, while less ink in the higher midtones will allow them to print slightly darker. 



So now, use this profile to print the 21 step tablet again.  Here is what I got when I did this a 
second time:

You can see that the curve did open up the deep shadows quite a bit. However, the midtones 
from about 60% to 30% are very flat and low contrast. There is almost no differentiation between 
tones. We need to make another attempt at correcting the curve. The way that I like to to this is to 
open up a random grayscale image in Photoshop, and then select Image->Adjustments->Curves... 
When the curves dialog comes up, I find the tiny triangle in the upper right corner and select “Load  
Preset” and select my old curve. 

Here is the curve we used for this better, but not really great profile:

As discussed above, the midtones are too flat. Hmmm. Look at the curve in the midtones. It is 
flat! So we are going to try to maintain the nice gradation in the highlights and spread out the 
midtones with a higher contrast gradation. 



So grab the points and move them around. I ended up with this:

Notice how I maintained the cross-over point, but slightly adjusted the point in the highlight 
area and steepened the entire curve below that. So at this point, we should save the curve with a 
new name, and use that to create a second iteration of our profile. 

Now is the time we should pull out the torture test negative. Go through the same profile 
creation process with this new curve, name it something different and print out the torture test (as 
alway, remembering to invert and flip the image in Photoshop prior to printing). 

Here is what we get:



This is a pretty good result. The scan may not do it justice, but the print shows increasing 
density for each 2% step on the 51 step tablet on the left side. The circle gradients do not show 
any pronounced steps that would indicate a discontinuity or sudden change in the gradient of our 
tones. Our third attempt is 98% there.  Perhaps, we could add a few point and steepen the curve 
coming out of the shadows and perhaps steepen the curve in the midtones slightly. But that is the 
sort of nitpicking that is worthwhile when you really have all your print process variables under 
control. 

So that is it for the first example. As soon as I have energy, I will cover another example using 
the Epson 1400 printer, which is dye ink printer with notoriously poor UV blocking properties and 
a propensity for smearing ink. QTR will allow us to laugh at these difficulties and produce a very 
fine profile. 

Later.


